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1. รายละเอียดเครื่องแม่ข่ายที่ติดตั้งระบบฯ 
หัวข้อ รายละเอียด 

สถาปัตยกรรม Server (OS) ระบบปฏิบัติการ Microsoft Windows Server 2016 Standard 
Public IP Address 10.136.24.133 
Processor Intel® Xeon® CPU E5-2670 v2 @2.50 GHz 
Storage 1000 GB 
RAM 16 GB 
 
2. การติดตั้ง .NET Core Hosting Bundle 
ดาวน์โหลด .NET Core Hosting Bundle 3.1 ที่  
“https://www.microsoft.com/net/permalink/dotnetcore-current-windows-runtime-bundle-
installer” 
 
3. การติดตั้งและตั้งค่า IIS Web Server (Internet Information Services Configuration) 

1. การติดตั้ง IIS สามารถท าได้โดยเปิด Server Manager จากนั้นเลือก Manage >> Add Roles 

and Feature 

 

 

 

 

 

 

รูปที่ 1 Open IIS 
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2. จากนั้นในส่วนของ Before You Begin คลิก Next 

 

 

 

 

 

 

รูปที่ 2 Add roles and features 

3. ส่วนของ Installation Type เลือก Rule-based or feature-based installation จากนั้นคลิก 
Next 

 

 

 

 

 

 

 
รูปที่ 3 Add roles and features 
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4. ส่วนของ Server Selection เลือก Select a server from the server pool จากนั้นคลิก Next 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 4 Server Selection 
 

5. ส่วนของ Server Roles เลอืก Web Server (IIS) 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 5 Server Roles 
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6. ส่วนของ Results รอการติดตั้งประมาณ 5 นาที เป็นอันเสร็จสิ้นการติดตั้ง IIS  
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 6 Install การติดตั้ง IIS 
 

7. ทดสอบการติดตั้ง IIS บนเครื่องโดยสามารถพิมพ์ที่ Web Browser คือ http://localhost/ 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 7 Server Roles 
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4.การติดตั้งระบบฯ (Deploy Application) 
1) จัดเตรียมไฟล์ Application ไว้ใน Server ตามต าแหน่งที่ต้องการ 

 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 8 หน้าหลัก IIS Web Server 
2) เปิด IIS Manager และกด Add Website 

 
 
 
 
 
 
 
 
 
 
 

  
รูปที่ 9 IIS Manager 
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3) จากนั้นใส่รายละเอียด Site Name เลือกที่อยู่ ไฟล์ Application จากข้อ 1 และกด OK เป็นอันเสร็จ 
 
 
 
 
 
 
 
 
 
 
 

 
รูปที่ 10 Add Website Manage 

4) ทดสอบการติดตั้งระบบ 
บนเครื่องโดยสามารถพิมพ์ที่ Web Browser คือ http://localhost 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 11 หน้าหลักของระบบฯ ที่ติดตั้ง 
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5. การตั้งค่าก าหนดแหล่งที่มาฐานข้อมูลระบบ (Database) 
1) เปิดไฟล์ Appsettings.json จากนั้น ก าหนดค่า ConnectionStrings >> MAINDB โดยการใส่ 

ชื่อ Server และ ชื่อ Database ที่เชื่อมต่อ ได้แก่  
 
 
 
 
 
 
 
 
 
 

 

รูปที ่12 ไฟล์ Appsettings.json ก าหนดแหล่งที่มาฐานข้อมูลระบบ (Database) 

ก าหนดค่า ConnectionStrings โดยการใส่ ชื่อ Server และ ชื่อ Database ที่เชื่อมต่อ ได้แก่ 
หัวข้อ รายละเอียด 

Server Name/IP address 10.136.24.132 
Database Name RLPD_WITNESS 
Database Username SA 
Database Password P@ssw0rd@ait 

6. สิทธิ์การเข้าสู่ระบบ 
รายละเอียดสิทธิ์เข้าสู่ระบบในระดับสิทธิ์การผู้ดูแลระบบสูงสุด 

หัวข้อ รายละเอียด 
URL https://www.rlpd.go.th/ 
Username Superadmin 
Password admin@Pa$$ 
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7. การติดตั้ง SSL Certificate 
 1. หากได้ SSL certificate เป็น Code ให้คัดลอกวางที่โปรแกรม Text Editor และบันทึกเป็น
นามสกุล .cer หรือ .crt 
    หากได้รับเป็นไฟล์แนบ ให้อ้างอิงชื่อไฟล์ที่มีชื่อ Domain อยู่ในไฟล์เป็นหลัก เช่น 
ssl_in_th_73822295eng_ssl_in_th.crt 
 2. หากได้ Intermediate CA เป็น Code ให้คัดลอกวางที่โปรแกรม Text Editor และบันทึกเป็น
นามสกุล .cer หรือ .crt 
    หากได้รับเป็นไฟล์แนบ ให้อ้างอิงชื่อไฟล์ที่มีค าว่า CA อยู่ในไฟล์เป็นหลัก เช่น 
ssl_in_th_73822295DigiCertCA.crt 
 3. ไปที่ IIS Manager ในส่วน Connections ให้ท าการเลือกเครื่อง Server ให้ถูกต้อง แล้วท าการคลิ๊ก
ที่ Server Certificates 
 
 
 
 
 
 
 
 
 
 
 
 

 
รูปที ่13 IIS Manager 

 4. ส่วนของ Action เมนูด้านขวามือ เลือก “Complete Certificate Request...” จะข้ึนหน้าต่างการ 
“Complete Certificate Request” ขึ้นมา 
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รูปที ่14 Complete Certificate Request 
 5. ในหน้าต่าง Complete Certificate Request ให้ด าเนินการดังนี้ 
File name … ให้ท าการเลือกไฟล์ SSL Certificate ที่เป็นนามสกุล .cer ที่ได้บันทึกไว้ในข้อที่ 1 
Friendly Name ให้ท าการระบุชื่ออะไรก็ได้เพ่ือใช้เรียก SSL Certificate ที่จะติดตั้ง 
Select a Certificate Store... ให้ท าการเลือก “Personal” 
  
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่15 Complete Certificate Request-2 
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 6. เลือก OK เพ่ือติดตั้ง SSL Certificate 
 7. ขั้นตอนต่อมา ท าการติดตั้ง Intermediate CA โดยเข้าสู่ Microsoft Management Console 
(MMC) โดยไปท่ี run >> mmc (ในกรณีมี Intermediate CA มากกว่า 1 เช่น Brand Comodo ให้ติดตั้ง
ด้วยวิธีเดียวกันส าหรับไฟล์ที่ 2 ได้เลย) 
  
 
 
 
 
 
 
 
 
 

รูปที ่16 Open Run 
 8. ที่ Menu bar เลือก File > Add/Remove Snap-in… 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่17 File > Add/Remove Snap-in 
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 9. เลือกหัวข้อ Certificate แล้วกดปุ่ม Add 
  
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่18 Add Certificate 
 10. เลือก “Computer Account” และกด Next 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่19 Computer Account 
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 11. เลือกหัวข้อ Local Computer กด Finish และ OK เพ่ือเข้าสู่หน้าหลัก Microsoft Management 
Console (MMC) 
  
 
 
 
 
 
 
 
 
 
 
 

รูปที ่20 Select Computer 
 12. ที่หน้าหลัก Microsoft Management Console (MMC) ให้คลิกท่ี Certificates (Local 
Computer) >> เลือก “Intermediate Certification Authorities >> Certificate” จากนั้นคลิกขวา All 
Tasks >> Import 
  
 
 
 
 
 
 
 
 
 
 
 

รูปที ่21 Microsoft Management Console 
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 13. เมื่อเข้าสู่หน้าแรกในการ Import กด Next จากนั้นเลือกท่ีตั้งไฟล์ Intermediate CA ที่ได้ท าการ
สร้างไว้ในข้อ 2 
  
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่22 Certificate Import Wizard 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่23 Certificate Import Wizard-2 
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 14. เลือก “Place all certificates in the following store” จากนั้นกด Next 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่24 Certificate Import Wizard-3 
 15. เมื่อท าตามข้ันตอนทั้งหมดเสร็จสิ้นแล้ว หาก Import ส าเร็จ จะข้ึนข้อความแจ้งเตือนว่า “The 
import was successful” 
  
 
 
 
 
 
 
 
 
 
 
 

รูปที ่25 Certificate Import successful 
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 16. เมื่อท าการติดตั้ง SSL Certificate และ Intermediate CA ทั้งหมดเรียบร้อยแล้ว จะเป็นขั้นตอน
การเรียกใช้ SSL Certificate โดยที่ IIS Manager ในสว่น Connections ด้านซ้ายมือ ให้ท าการเลือก Sites 
และเลือกเว็บไซต์ที่ต้องการติดตั้ง SSL ให้ถูกต้อง 
 17. เมนู “Action” ด้านขวามือ เลือก “Bindings...” 
  
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่26 Bindings 
 18. ในหน้าต่าง “Site Bindings” เลือก “Add...” 
  
 
 
 
 
 
 
 
 
 
 

รูปที ่27 Add Site Bindings 
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 19. คลิกปุ่ม Add แล้วระบุข้อมูลต่างๆดังนี้ 
Type: ให้ท าการเลือก https 
IP address: ท าการเลือก All Unassigned หรือเลือก IP เว็บไซต์ให้ถูกต้อง 
Port: ให้ก าหนดเป็น Port 443 
Host name: ให้ปล่อยเป็นค่าว่าง 
SSL Certificate: ให้ท าการเลือกไฟล์ certificate ที่ได้ติดตั้งไว้ 

  
 
 
 
 
 
 
 
 
 
 
 

รูปที ่28 Add Site Bindings-2 
 20. หลังจากติดตั้งเสร็จแล้ว ให้ท าการตรวจสอบการติดตั้ง SSL Certificate โดยผ่านทางเว็บไซต์ 
https://ssl.in.th/ssl-checker/ 
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8. build pakegae การติดตั้งระบบ 

8.1 สร้าง Folder ที่ต้องการเก็บไฟล์ build ระบบคุ้มครองพยาน 

 

 

 

 

 

 

รูปที ่29 สร้าง Folder   

8.2 เปิด Source Code Project ด้วยโปรแกรม Visual Studio 2019   

 

 

 

 

 

 

 

รูปที ่30 Source Code Project 
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      แสดงโปรแกรม Visual Studio 2019   

 

 

 

 

 

 

รูปที ่31 Visual Studio 2019 

8.3 Build ไฟล์  WEB 
 1. คลิกขวาที่ RLPD 

 

 

 

 

 

 

รูปที ่32 Build RLPD 

 



 Installation Manual 
โครงการพัฒนาระบบสารสนเทศการคุ้มครองพยาน 

 
Prepared by: คุณธนาเศรษฐ์ วสุธนเวโรจน ์ Reviewed by: คุณปุณวิพัชร์ นนทะไชย 
Date: 26/10/2020  Date: 30/10/2020 
 

Installation Manual:     Page 22/45 

 2. เลือก Publish… 

 

 

 

 

 

 

รูปที ่33 Select Publish… 

 3. เลือก Target  -> Folder  และคลิก Next 

 

 

 

 

 

 

รูปที ่34 เลือก Target 
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 4. คลิก Browse...  เพ่ือ เลือก Folder ที่ต้องการบันทึกไฟล์ Build 

 

 

 

 

 

 

รูปที ่35 Browse File 

 5. เลือก Folder ที่ต้องการจัดเก็บ และคลิก OK 

 

 

 

 

 

 

รูปที ่36 Select Folder File 
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 6. คลิก Finish 

 

 

 

 

 

 

รูปที ่37 Finish 

 7. คลิก Publish เพ่ือเริ่มการ Build ไฟล์ 

 

 

 

 

 

 

รูปที ่38 เลือก Publish 
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 8. Build ไฟล์ส าเร็จ 

 

 

 

 

 

 

รูปที ่39 Build successful 

9. ขั้นตอนการจัดการฐานข้อมูล 
9.1 การติดตั้ง Install Sql Server 2019 

 1. เปิดไฟล์ SQLServer2019 จากนั้นคลิกไฟล์ Setup.exe ดังรูป 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 40 Setup Program 
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 2. จากนั้นจะมีหน้า ให้คลิกเลือก New SQL Server stand-alone installation 
 
 
 
 
 
 
 
 
 
 

รูปที่ 41 New SQL Server stand-alone installation 
 
 3. เลือกยอมรับการ Check For Updates หรือไม ่จากนั้นคลิก Next 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 42 Check For Updates 
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 4. แสดงขั้นตอนการติดตั้งไฟล์ 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 43 Install Setup Files 
 
 5. หากไม่มีอัพเดทโปรแกรมจะแสดงหน้าจอ ต่อมาจะเป็นการตรวจสอบความพร้อมส าหรับการ
ติดตั้ง ซึ่งต้องขึ้นเป็นสีเขียวทั้งหมด แต่หากมีสีเหลืองก็ติดตั้ง ยังสามารถติดตั้งได้ (ตามรูปตัวอย่าง) ให้คลิก 
Next 
 
 
 
 
 
 
 
 
 
 

รูปที่ 44 Install Rules 
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 6. เลือก Feature ตามท่ีต้องการใช้งาน หรือ เลือกตามที่โปรแกรมแนะน าให้ จากนั้นคลิก Next 
 
 
 
 
 
 
 
 
 
 

รูปที่ 45 Feature Selection 
 

 7. เลือกท่ี Default instance ก าหนดเสร็จแล้วก็คลิก Next 
 
 
 
 
 
 
 
 
 
 

รูปที่ 46 Instance Configuration 
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 8.  แสดงค่า Server Configuration (Default ตามระบบ) แล้วก็คลิก Next 
 
 
 
 
 
 
 
 
 
 

รูปที่ 47 Server Configuration 
 
 9.  เลือกรูปแบบส าหรับ Login เข้าฐานข้อมูล Windows authentication mode จากนั้นกด 
Next 
 
 
 
 
 
 
 
 
 
 

รูปที่ 48 Server Configuration 
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 10. รอให้ติดตั้งจนเสร็จ แล้วจะข้ึน Complete ตามรูป 
 
 
 
 
 
 
 
 
 
 

รูปที่ 49 Install Complete 
  
 11. จากนั้นก็เปิดไฟล์ SSMS-Setup-ENU.exe ให้คลิกปุ่ม Install เพ่ือติดตั้ง SQL Server 
Management Studio  
 
 
 
 
 
 
 
 
 
 

รูปที่ 50 Install SSMS 
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 12. จากนั้นรอการติดตั้งจนเสร็จ 
 
 
 
 
 
 
 
 
 
 

รูปที่ 51 Waiting Install SSMS 
 

 13. ติดตั้ง SSMS เสร็จสิ้น  (แนะน ากดปุ่ม Restart ) 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 52 Install SSMS Complate   
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 14. เปิดโปรแกรม SQL Server Management Studio 18 เพ่ือเข้าใช้งาน ฐานข้อมูล ดังรูป 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 53 SQL Server Management Studio 18 
 

15. เข้าใช้งาน SQL Server 2019 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 54 Open SQL Server 2019 
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9.2 การ Backup DataBase 
เปิด Tool ของ SQL Server Management Studio และท าการเชื่อมต่อไป Database ของ SQL 

Server 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 55 Open Tool Sql Server 
รายการ Database ที่ต้องการจะ Backup 
       คลิกขวาที่ Database ->Tasks -> Backup 

 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 56 Backup 
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หน้าจอนี้เป็นการเลือกรายการที่จะ Backup เช่น เลือก Database, สว่น Backup type : Full และ
ค่าอ่ืน ๆ สามารถก าหนดเป็นค่า Default ได้เลย 
ในเบื้องต้นหน้าจอนี้โปรแกรมจะก าหนด Path ที่เป็นค่า Default ราสามารถ Remove มันออกไปได้เลย 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 57 Backup 
เลือก Add ใหม่ 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 58 New Add.. 
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ก าหนด Path ที่ต้องการ Backup  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 59 Select Backup Destination 
ก าหนดชื่อไฟล์ และแนะน าให้ใส่นามสกุลเป็น .bak จากนั้นกดปุ่ม OK 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 60 ก าหนดชื่อไฟล์ 
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แสดงหน้าจอการเลือกแหล่งข้อมูลที่จะ Backup จากนั้นกดปุ่ม OK 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 61 แหล่งข้อมูลที่จะ Backup 
 หลังจากท่ีได้ Path เรียบร้อยแล้วให้เลือก OK เพ่ือเริ่มการ Backup ข้อมูล   
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 62 Path File 
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 แสดงข้อมูลการ Backup เรียบร้อยแล้ว 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 63 Backup Successful 

9.3 การ Restore DataBase 
ในการ Restore ตัว Database ของ SQL Server สามารถ Restore ได้ทั้งในกรณีท่ีทับ Database 

ที่มีอยู่แล้ว  
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 64 Select Restore Backup 
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แสดงหน้าจอ Restore Database จากนั้น เลือก Source > Device กดปุ่ม Browser.. เพื่อหาไฟล์ 
Backup 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 65 Source Device 
 กดปุ่ม Add 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 66 New Add 
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เลือกไฟล์ที่ได้ท าการ Backup ไว้หรือจาก Path ที่ได้ Copy มาจากเครื่องอ่ืน ๆ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 67 Select File Backup 
หลังจากท่ีได้ Path แล้วให้คลิก OK 
 
 
 
 
 
 
 
 
 
 
 
 

 
รูปภาพที่ 68 Select File Backup-2 
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ในกรณีที่ยังไม่มี Database ให้ท าการพิมพ์ชื่อ Database ในส่วนของ To database: 
และจากรายการ Restore จากนั้นกด OK 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 69 เลือกรายการข้อมูลที่ Restore 
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จากนั้นให้ผู้ใช้คลิกปุ่มเลือก “Options” > “Overwrite the existing database (WITH REPLACE)” > 
“OK”  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 70 เลือกรายการข้อมูลที่ Restore 
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จากนั้นให้ผู้ใช้รอ Progress แสดงผล 100 เปอร์เซ็นต์ 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 71 รอ Process Restore Database 
ระบบจะแสดงหน้าต่าง Microsoft SQL Server Management Studio ขึ้นมา เพ่ือยืนยันการ 

Restore ข้อมูลเสร็จสิ้น จากนั้นให้คลิกปุ่ม “OK” 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 72 Resotre Complate 
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10. การใช้งานโปรแกรม FileZilla 
10.1 การเชื่อมต่อ FTP Server 

 1. เปิดโปรแกรม FileZilla ขึ้นมาจะได้หน้าต่างโปรแกรม ดังรูป 
 
 
 
 
 
 
 
 
 

รูปที่ 73 FileZilla 
 2. เมื่อเปิดโปรแกรมข้ึนมาจะพบหน้าต่างให้ตรวจสอบการอัพเดต ก็ให้คลิกปุ่ม Close ดังรูปที่ 
94 (ไม่จ าเป็นต้องตรวจสอบการอัพเดตก็ได้ หรือถ้าใครจะอัพเดตก็สามารถท าได้) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 74 Check for Update 
 



 Installation Manual 
โครงการพัฒนาระบบสารสนเทศการคุ้มครองพยาน 

 
Prepared by: คุณธนาเศรษฐ์ วสุธนเวโรจน ์ Reviewed by: คุณปุณวิพัชร์ นนทะไชย 
Date: 26/10/2020  Date: 30/10/2020 
 

Installation Manual:     Page 44/45 

 3. ก็จะปรากฏหน้าต่างโปรแกรม FileZilla ดังรูปที่ b3 

 

 

 

 

 

 

 

 

รูปที่ 75 FileZilla 
 
 4. ในหน้าต่างการก าหนดค่าการเชื่อมต่อนี้ 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 76 Connect FileZilla 
 

1. พิมพ์ 10.136.24.133 

2. Username ที่ได้รับ 

3. Password ที่ได้รับ 4. คลิก 
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5. เมื่อเชื่อมต่อส าเร็จจะปรากฏหน้าต่าง ดังรูป 
 
 
 
 
 
 
 
 
 
 

รูปที่ 77 Connect successful 
 

10.2 การอัพโหลดไฟล์ (File Upload) 

 1. เลือกโฟลเดอร์ปลายทาง (Server) ที่เราต้องการอัพโหลดไฟล์ไปเก็บ จากนั้นดับเบิ้ลคลิกเปิด
โฟลเดอร์นั้น ซึ่งเมื่อเรา Double click เข้าโฟลเดอร์ที่เราต้องการ 

  

 

 

รูปที่ 78 เลือกข้อมูลโฟลเดอร์ 

 2. เลือกไฟล์ที่เราต้องการอัพโหลดจากทางฝั่งเครื่องของเรา (Client) 

 

 

 

รูปที่ 79 เลือกข้อมูลโฟลเดอร์ 

เลือกไฟล์ที่ต้องการ 


